Chapter 134

Tests for the Ratio of Two Variances

Introduction

This procedure calculates power and sample size of inequality tests of total (between + within) variabilities from a two-group, parallel design for the case when the ratio assumed by the null hypothesis is equal to one. This routine deals with the case in which the statistical hypotheses are expressed in terms of the ratio of the variances.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 217 - 220.

Suppose $x_{ij}$ is the response of the $i$th group ($i = 1, 2$) and $j$th subject ($j = 1, \ldots, N_i$). The model analyzed in this procedure is

$$x_{ijk} = \mu_i + e_{ij}$$

where $\mu_i$ is the treatment effect and $e_{ij}$ is the between-subject error term which is normally distributed with mean 0 and variance $V_i = \sigma^2_{Bi}$. Unbiased estimators of these variances are given by

$$\hat{V}_i = \frac{1}{N_i - 1} \sum_{j=1}^{N_i} (x_{ij} - \bar{x}_i)^2$$

$$\bar{x}_i = \frac{1}{N_i} \sum_{j=1}^{N_i} x_{ij}$$

A common test statistic to compare variabilities in the two groups is $T = \hat{V}_1 / \hat{V}_2$. Under the usual normality assumptions, $T$ is distributed as an $F$ distribution with degrees of freedom $N_1 - 1$ and $N_2 - 1$.

Testing Variance Inequality

The following three sets of statistical hypotheses are used to test for variance inequality

$$H_0: \frac{\sigma^2_1}{\sigma^2_2} \geq 1 \text{ versus } H_1: \frac{\sigma^2_1}{\sigma^2_2} < 1,$$

$$H_0: \frac{\sigma^2_1}{\sigma^2_2} \leq 1 \text{ versus } H_1: \frac{\sigma^2_1}{\sigma^2_2} > 1,$$

$$H_0: \frac{\sigma^2_1}{\sigma^2_2} = 1 \text{ versus } H_1: \frac{\sigma^2_1}{\sigma^2_2} \neq 1,$$

where one is the variance ratio assumed by the null hypothesis.

The corresponding test statistics are $T = (\hat{V}_1 / \hat{V}_2)$.
Power

The corresponding powers of these three tests are given by

\[ \text{Power} = P \left( F < \left( \frac{1}{R_1} \right) F_{\alpha, N_1-1, N_2-1} \right) \]

\[ \text{Power} = 1 - P \left( F < \left( \frac{1}{R_1} \right) F_{1-\alpha, N_1-1, N_2-1} \right) \]

\[ \text{Power} = P \left( F < \left( \frac{1}{R_1} \right) F_{\alpha/2, N_1-1, N_2-1} \right) + 1 - P \left( F < \left( \frac{1}{R_1} \right) F_{1-\alpha/2, N_1-1, N_2-1} \right) \]

where \( F \) is the common F distribution with the indicated degrees of freedom, \( \alpha \) is the significance level, and \( R_1 \) is the value of the variance ratio stated by the alternative hypothesis. Lower quantiles of \( F \) are used in the equation. A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary sample size.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

**Solve For**

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

**Test Direction**

**Alternative Hypothesis**

Specify whether the alternative hypothesis of the test is one-sided or two-sided.

**Two-Sided Hypothesis Test**

H0: \( \sigma_1^2 / \sigma_2^2 = 1 \) vs. H1: \( \sigma_1^2 / \sigma_2^2 \neq 1 \)

**One-Sided Hypothesis Tests**

Lower: H0: \( \sigma_1^2 / \sigma_2^2 \geq 1 \) vs. H1: \( \sigma_1^2 / \sigma_2^2 < 1 \)

Upper: H0: \( \sigma_1^2 / \sigma_2^2 \leq 1 \) vs. H1: \( \sigma_1^2 / \sigma_2^2 > 1 \)
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on N1 or N2 or both.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter N2, solve for N1**
  Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

- **Enter R = N2/N1, solve for N1 and N2**
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
  \[ N2 = R \times N1. \]

- **Enter percentage in Group 1, solve for N1 and N2**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
*This option is displayed if Group Allocation = “Enter N2, solve for N1”*

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.
Tests for the Ratio of Two Variances

R (Group Sample Size Ratio)

This option is displayed only if Group Allocation = “Enter \( R = N_2/N_1 \), solve for \( N_1 \) and \( N_2 \).”

\( R \) is the ratio of \( N_2 \) to \( N_1 \). That is,

\[
R = \frac{N_2}{N_1}.
\]

Use this value to fix the ratio of \( N_2 \) to \( N_1 \) while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this ratio are considered.

\( N_2 \) is related to \( N_1 \) by the formula:

\[
N_2 = \lceil R \times N_1 \rceil,
\]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N_1 = 10 \) and \( N_2 = 20 \), or \( N_1 = 50 \) and \( N_2 = 100 \)).

\( R \) must be greater than 0. If \( R < 1 \), then \( N_2 \) will be less than \( N_1 \); if \( R > 1 \), then \( N_2 \) will be greater than \( N_1 \). You can enter a single or a series of values.

Percent in Group 1

This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for \( N_1 \) and \( N_2 \).”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for \( N_1 \) and \( N_2 \). Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)

Group Allocation

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal \( N_1 = N_2 \)**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter \( N_1 \) and \( N_2 \) individually**
  
  This choice permits you to enter different values for \( N_1 \) and \( N_2 \).

- **Enter \( N_1 \) and \( R \), where \( N_2 = R \times N_1 \)**
  
  Choose this option to specify a value (or values) for \( N_1 \), and obtain \( N_2 \) as a ratio (multiple) of \( N_1 \).

- **Enter total sample size and percentage in Group 1**
  
  Choose this option to specify a value (or values) for the total sample size (\( N \)), obtain \( N_1 \) as a percentage of \( N \), and then \( N_2 \) as \( N - N_1 \).
Tests for the Ratio of Two Variances

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal \( N1 = N2 \).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for \( N1 \), and also the value for \( N2 \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

\( N1 \) (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter \( N1 \) and \( N2 \) individually” or “Enter \( N1 \) and \( R \), where \( N2 = R \times N1 \).”

\( N1 \) is the number of items or individuals sampled from the Group 1 population.
\( N1 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( N2 \) (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter \( N1 \) and \( N2 \) individually.”

\( N2 \) is the number of items or individuals sampled from the Group 2 population.
\( N2 \) must be \( \geq 2 \). You can enter a single value or a series of values.

\( R \) (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter \( N1 \) and \( R \), where \( N2 = R \times N1 \).”

\( R \) is the ratio of \( N2 \) to \( N1 \). That is,

\[
R = \frac{N2}{N1}
\]

Use this value to obtain \( N2 \) as a multiple (or proportion) of \( N1 \).
\( N2 \) is calculated from \( N1 \) using the formula:

\[
N2 = \lceil R \times N1 \rceil,
\]

where the value \( \lceil Y \rceil \) is the next integer \( \geq Y \).

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1.
\( R \) must be greater than 0. If \( R < 1 \), then \( N2 \) will be less than \( N1 \); if \( R > 1 \), then \( N2 \) will be greater than \( N1 \). You can enter a single value or a series of values.

Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines \( N1 \) and \( N2 \).

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.
Effect Size

R1 (Actual Variance Ratio)

Enter one or more values for variance ratio assumed by the alternative hypothesis. This is the value of $\sigma_1^2 / \sigma_2^2$ at which the power is calculated.

The range of possible values is $R1 > 0$. $R1 \neq 1$.

Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to compare it to the standard drug in terms of the variance. A parallel-group design is used to test the inequality using a two-sided test.

Company researchers set the variance ratio under the null hypothesis to 1.0, the significance level to 0.05, the power to 0.90, and the actual variance ratio values between 0.5 and 2 (excluding the null hypothesis value, 1.0). They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Ratio of Two Variances procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option

Design Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided (H1: $\sigma^2_1/\sigma^2_2 \neq 1$)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.5 0.8 0.9 1.111 1.25 2</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Group 1 Sample Size</th>
<th>Group 2 Sample Size</th>
<th>Actual Variance Ratio</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9017</td>
<td>90</td>
<td>90</td>
<td>180</td>
<td>0.500</td>
</tr>
<tr>
<td>0.9003</td>
<td>847</td>
<td>847</td>
<td>1694</td>
<td>0.800</td>
</tr>
<tr>
<td>0.9001</td>
<td>3789</td>
<td>3789</td>
<td>7578</td>
<td>0.900</td>
</tr>
<tr>
<td>0.9000</td>
<td>3796</td>
<td>3796</td>
<td>7592</td>
<td>1.111</td>
</tr>
<tr>
<td>0.9003</td>
<td>847</td>
<td>847</td>
<td>1694</td>
<td>1.250</td>
</tr>
<tr>
<td>0.9017</td>
<td>90</td>
<td>90</td>
<td>180</td>
<td>2.000</td>
</tr>
</tbody>
</table>
Tests for the Ratio of Two Variances

References

Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.
N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
R1 is the value of the variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements
A study is being conducted to compare the variances of a treatment group and a control group using a two-sided hypothesis test. Group sample sizes of 90 and 90 achieve 90% power to reject the null hypothesis at a significance level of 0.050. The variance ratio assumed by the null hypothesis is 1. The variance ratio at which the power is calculated is 0.500.

This report gives the sample sizes for the indicated scenarios.

Plot Section

These plots show the relationship between sample size and R1.
Example 2 – Validation using Davies (1971)

Davies (1971) page 41 presents an example with $R_1 = 4$, $Alpha = 0.05$, and $Power = 0.99$ in which the sample sizes, $N_1$ and $N_2$, are calculated to be 36 assuming a one-sided hypothesis. We will run this example through PASS.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Ratio of Two Variances procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: $\sigma^2_1/\sigma^2_2 &gt; 1$)</td>
</tr>
<tr>
<td>Power</td>
<td>0.99</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>4</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>H0: $\sigma^2_1/\sigma^2_2 \leq 1$ vs. H1: $\sigma^2_1/\sigma^2_2 &gt; 1$</td>
<td></td>
</tr>
<tr>
<td>Actual Power</td>
<td>0.9914</td>
</tr>
<tr>
<td>Group 1 Sample</td>
<td></td>
</tr>
<tr>
<td>N1</td>
<td>36</td>
</tr>
<tr>
<td>Group 2 Sample</td>
<td></td>
</tr>
<tr>
<td>N2</td>
<td>36</td>
</tr>
<tr>
<td>Actual</td>
<td></td>
</tr>
<tr>
<td>Variance Ratio</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>72</td>
</tr>
<tr>
<td>R1</td>
<td>4.000</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The sample sizes match the results in Davies (1971).